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YT IR R B SR

ST R

S HTIAE TEAE O AT E A -

SPATREAE FT RO © B2 T IEAEAE TR, - R AR QlAstat-Dx g et
& SEEAOKET TR -

% | administrator | (EEEE) HATIEAE/TH4E 1 FifiTF Resp_3018_19¢
HIEL - SERCHIEVERRSE 32 43 14 7 -

{Fi% | administrator | (EELE) HAICALESAL L LT Resp Panel il
B -

HE FPE A BT BT R

TEST COMPLETED (HIBAEISER) © MIBEAH IR -

TEST FAILED CHIBRARD * MBEAsER - (R UIBHR -

TEST CANCELLED (HIETHUY) © EHEHUY T8 -

L QUAStatDx ML E: - SUMIE ACTHIZ TIE - S Hr i 2T A -
SHHTIA T QIAStatDX IRIBURIE: » BUARIE AT T ELAKRIED » (0 E TR HE T
B e DL T TR e ¢

© [RECKHIBTHEL % o KA -

® ZRRARANE - SUBIRTMES T -

6.1.3 FIHRERY

* 3 BURNEAE ] LUE R EThReRY B FIHYEEA -

3. ETHEERIIEIR

R s

Run Test CEE{THIE) BB TR (E2REEE 5.3 ) - QlAstat-Dx Hhg H By EEHL A FIY 3 1

T BAAE IR A P 5 -
View Results (g iR4E54) FT5A View Results (fi455) @5 (F2h (56 5.4 i) -

Options (#1H) #UT Options (E815) TIhRER (FH2RHI5 6.4 i) -

@00 O3

Log Out () BRI =ES ({S7ERUA T User Access Control [{s i (R HUZERI] B A0
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6.1.4 NAEEE

TN F R T BURHVE G A R & HGIRRR A AT (b o AR FEERAAE T STl HIThaE
RPBEIEER > GEZERTERGR  HE - LA

FRIZNZ - AJiEH Tab menu (FEERIIAESR ) WA Options (EEIH) LOERIIT BT ZEIH -
T Options (#E75) %R AI{FHL Options (#E5H) T-IhRE ([E 43) -

administrator Test Details 14:49 2017-03-30

—l Available °

Run Test

i)

View
Results

SO0@®@0

say System Change
MGMT  MGMT  Config Password

® ©

Log Out

B 43 FFRUBTETINRER -
6.2 login (& A) &

MERBLHT User Access Control ({#HEFFEIESH]) (2R 6.5 &) - AIFEAENEERS
AR E NS - BEEA BT QlAstat-Dx Analyzer 1.0 IAAE ©

FEEER  F—EAMS > {3 1D & " administrator , > TSR T administrator | 55—
RENBWNEEEE T -

BANBERAINETESREEHNEA User ID ((EF# ID) Ay (T—HIE 44) - WIREEH
T Show previous user logins (#URZFIRIEEFIEEA) B85 - RIEEER ZAIMEIE AR 5
EFE S E -

Wt © BRG T ARIRES RS BT HAEH QIAGEN FZHEA SR -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

49



No user LogIn 12:40 2019-02-15

o

44.login (BA) BH -

H—TNEEP R H b —EA e — T User ID (fEFI%E 1D) X577 8RIG(0 A e iy A 478
BImT AL &1 - fa AR EAT8IL - % TR ERURHGC R EITIERE (8 45) -

No user Login 16:38 2017-03-30

UserID |abuser Password

X space v

45 fRin U R R -

BT Require password (FREEH) BH - (H2EEE 6.5 &) - AIEERHNEAZ
ST HERIEE fede e - AR THREEN > AIEB LTI g EX -

MR HE SECEH CVE > 2% Administrator (B & ) TJLIERES -

L - REH ATEEC TS - JIAEH QIAGEN FifififilfIEss - iE7%E QIAGEN k5T
TERTEIZEIRY; - NICER S I —(EE AR -

sk IR B ER L 2PRIVE B -
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6.2.1 5¥iH

MERBLHT User Access Control ({fHEFFEEES]) (52R5E 6.5 &) » HHFE B EA T
DHRERM Y Log Out (B H) BEEKEH - 3£ R 6.1.3 ffi -

T HBE R - (EAER B - IS AT{E Options (EEIH) THEEFRHY General (F#T)
RETECE (FH2EE 6.7.261) -

6.3 FRERERERN

WIERE B FUE RIS FE R TE S R(E - AIEEUR QlAstatDx B {ri i B -
Z 5 AT{E Options (8835) DhRERTICE (H2H%F 6.4 i) -

B ORE AL B AR U TS A AY T P ME DL RORIEASE iR RIER ISR ([ 46) -

[ 46 BRAREAERE MR —E o Ry -

6.4 Options (#ETH) IhEEF
Options (#EIH ) INREFRFTLAME EINRERFIGFEL - & 4 BRI v DU FAAYEEE « R ] Ay EE
S EER -

5% 4.Options (&) TIRER
g

Assay Management (fgHIEH )

718

AR R A P B A ERAR -
AR S AT P AR E B B A A s EAE
AR PRV B R ICE A4 -

User Management ({5 fH#E&H )

System Configuration ( Z%54HAE )

0000}

Change Password ( 85 %185 ) SRR T User Access Control (& {FEGES]) - AlEZEEE ] -
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6.5 fEAEEH

QlAstatDx AR EE - ARSI RFIRVIERRS - B A BN - A
DL -

e Single User (EE{fifH%) =L @ User Access Control (& FHUE ) C&UEH - FEHEs
A QlAstatDx Analyzer 1.0 F{sE FHEHEITEAM2ER] - FTAEFHEITRTLUE A QlAstat-Dx
Analyzer 1.0 HYFTELIAE » 2B EAIIRA] -

e Multi-User (Z{f %) 5z : User Access Control ({f & FHWER]) CABUH - fERELH
BA 0 A& HEAE QlAstat-Dx Analyzer 1.0 S THE(E « PP THVIRIE & Z 2R -
AR R e E R -

fEE © User Management ({5 ) BEIH{E 3 AR " Administrator , (BHH) 5

MLaboratory Supervisor ; (‘Eha= T ) SEMNFERE -

#5=E  A[LIAE Options (#EI1E ) IhEEF Ry System Configuration ( Z454H58) AV General (3
) BE R EUE A User Access Control ({f F# 7B ) -

User Management (&S ) BEIE 2R " Administrator ;| (E¥ & ) 1 " Laboratory
Supervisor | (EEZETE) NEMEIVFERAERZGHINERE - ERHERERNMERH SR ERE
DUR BREh s A -

% 5 BUR T QlAstat-Dx Analyzer 1.0t ] DU IR FHE S ERE

2 5.QIAstat-Dx Analyzer 1.0 Ha] BA{E FE 8{EE F o o i

BRI R iy ] R

Administrator (& ) SE4 BEER/T BT

Laboratory Supervisor Wi e BREATA

(FR=EE) RIS S AR
TR IR 5 T A (5 i 1 s

Advanced User CHEFS(EF%) AT MRS - ERERITAR
R B (P AR E AR (BT
%)

Basic User (JEA(#RI%) T H BRI E (Pl L -
Eﬁi Eij;fﬁﬁ%ﬁﬂﬂ%ﬁa@#sﬁmﬁsﬁ (B, BE S ENEES)
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6.5.1 FHUIEHREHZEFE

IR N S BAF N E B A S

1. ##7 Options (BEIE) 78 - #A%$% T User Management ({#AEEME) I KEICEFHS -
BRSNS &S H I User Management ({HEI#AH) A5 (B 47)

administrator User MGMT 14:49 2017-03-30
—I Available °
Run Test
USER
administrator > e
technician > =
View
labuser > Leauite
Options
Log Out
20 adduser E] save ® cancel

B 47.User Management ({EFEEH) B8 -

2. ENEEISEME Ty E RN S (8 48) -

administrator User MGMT 14:49 2017-03-30
1 Available °
Run Test
USER USER OPTIONS
administrator > e
technician > e
F ord
labuser > B
User Active @ e
Options
Assign user profile >
Assign Assays > @
Accav Qtatictine S Log Out
20 Add user E] save ® cancel
I 48 EAFIEHFERZ o

3. RIS EEEURI4R R DL T 580
O User Name ({EFH#EATE) © FFMREHEAE -
O Password (M) © MEFE T LA
O User Active (yes/no) ({FFRERIE) [B/&]) @ nifEEFREEERE) - REETERE
HEA TS A 280 E T RAE -
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O Assign User Profile (/ECHEAERER) © nefhZERESICARIEAESER (6
41 > Administrator [ §] - Laboratory Supervisor [E#= T %&] - Advanced User [#[&
] ~ Basic User [FAMAE]) - fENEREEGHINS BEERN & HENE HERER

([ 49) -
administrator User MGMT 12:03 2017-07-03
—] Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator > Administrator e
technician > Passin Laboratory Supe... View
ppan > e Advanced User v peaits
useractive @ Basic User
Assign user profile > Service Technician Options
Assign Assays >
Assay Statistics > @
Log Out
20 adduser E] save ® cancel
B 49. RERFSEEREREH -

O Assign Assays (STEMH)  ATHEREFIE A FIITHIMAIEDIIR AN - fEPI A EHL
I BRI (T —EE 50) -

administrator User MGMT 14:49 2017-03-30
_] Available e
Run Test
USER USER OPTIONS ASSAYS
administrator > Resp Panel & e
technician > ¢ i i
labuser > Genilts
User Active q b
Assign user profile > Pptions
Assign Assays >
Assay Statistics > @
Log Out
20 Add user =] save ® cancel

8 50. RAEAE I o

O Assay Statistics (falstat &) © BURATEERE AZ = TR R E (& 51) -
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administrator User MGMT 14:50 2017-03-30

—I Available °
Run Test
USER USER OPTIONS ASSAY STATISTICS
administrator > Resp Panel e
technician > ¢ i Vi
labuser > Goaiits
User Active @
Assign user profile > Sptions
Assign Assays >
Assay Statistics > @
Log Out
20 adduser E] save ® cancel

B 518w E -

4. $%T Save (f#{7) i Confirm (FEsR) (H{F#E - IL4b - th [T Cancel (HUH) I
Confirm (TEsf) FER#E -

6.5.2 A

IR DL AR By QlAstat-Dx Analyzer 1.0 #ridffi g ¢

1. #F Options (E1E) $#8H - A& T User Management ({5 f5EH) #HKECEHF A -

BRSNS @IS & R User Management ({EHIEER) w5 ([E 52) -
52 FMEEFE -

2. ¥R T AR Add User GRS ) SR B R 40mm g -

3. ez En A R HY User Name (i3 4478 ) 1 Password (5t ) -

4. #% Assign User Profile (Z3CEIESCERE) W (EAEEISGHIERE) Kol H#E il &
HIE R E R ERE (B 53) -

administrator User MGMT 17:25 2017-03-30
—] Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator > er Nan Administrator e
technician > newUser Laboratory Supe... Vi
iew
labuser > Gt Advanced User entlts
> Basic User v
User Active @ 5 "
Service Technician Options
Assign user profile >
> (O]
> Log Out
20 Add User E] save ® cancel
S3.RAEAESEEREREHE
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5. 1% Assign Assays (srBctedl]) A (FERUREVERANE SRS ) BERUE M & STl THIRH -

6. % I Save (f#{7) Wi Confirm (HEY) GEFFIFEERIEN - F{FAECLRIETE » 121
HIZ& A QlAstat-Dx Analyzer 1.0 -

6.6 falEH
1£ Assay Management (R HIEEE) ShgEZRrt - W DU MIAA UM AR B R R gt et -

R Assay Management (g% 2 ) B0 {3 A HY (6 A " Administrator ; (EELE ) 5
"Laboratory Supervisor ; (EEREEE ) BUEMEVERE -

6.6.1 EEHEHIAYRHI
HIED T EE T QlAstat-Dx Analyzer 1.0 A

1. ¥ | Options (EETE) %8 - ZR7%¥% N Assay Management (fg R EE ) $28H 5K EHT Assay
Management (g 5] ) S5 o WA — s T ekl (& 54) -

administrator Assay MGMT 14:50 2017-03-30

1 Available °

Run Test

AVAILABLE ASSAYS 08437015450506

Resp Panel % Assayactive @ e
Assay IC View
08437015450506 Results
Respiratory Panel
';.0 y Options
Assay Notes >
Type of Samples > @

Log Out
[ import S] save ® cancel
548w FIRHRRH -

2. FEREEIGAAY Pz T2 E ARl -
3. BEHUR 6 fHiiEE Yy — (F—H) -
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& 6 MHE

ks it

Assay Active (HHIELT)) S T LR MR E R -
fHRRE ¢ AN R BUERIRAE - A BRI RN QIAstatDx fllsAA & -

Assay ID (#&Hl ID) TR ELRHIER A5 -

Assay Description (gl ) FRftha 42 -

Assay Version (gRIRRA) TREERRIRRA -

LIS assay name (LIS ffil44f% ) FEALRA LIS Rl

Assay Notes (fgfllffaE) FRACHR AT A AR R -

Type of Samples (HEAKHEL) FRAER S AR S TR AL B -

List of Analytes (3455 ) R Y BRI TR A -

List of Controls ( B 7]57% 55 ) PR P FH AR AT R B

Assay Statistics (fglIfEsTERH) FEfit QlAstat-Dx Analyzer 1.0 FrEErHIRTHIGETTRE > DARFSME ~ &tk - elig
FIEHUH AR S -

6.6.2 [EATHRHI
FHALL T B B QIAstatDx Analyzer 1.0 [ A FiasHl -

1. BEaFHE AT HREN USB EiEEiE A QlAstat-Dx Analyzer 1.0 {Y USB E##FE o

2. B HINE A QlAstat-Dx Analyzer 1.0 » 354% | Options (#8IH ) #4351 » K184 [ Assay
Management (fHIE ) f#8f - BRSNS ERE HIR Assay Management (& IIEHE )
e (& 55) -

scmiisirale sy MGNT 1118181018
O Avalable

4 aailable e

1 )
Available £ dvailable

AVAILABLE ASSAYS Assay01 Run Test
Assay0l > Assay Active D
Respiratary >
0000000000000
) o
English deseription Results

1.0

LIS assay name
Assay Notes
Type of Samples
List of Analytes

List of Controls

Assay Statistics Log Out

E meon Bl e ® conce

55.Assay management screen (HHIESHRBE) -

3. ¥ NER/S M A Import (MEA) [E -
4. f USB {FUEE Hr R HUEA R E A M HIAE S BRI HE A% - B 7B A T LA - AREDRIZKE
A SR HERE
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5. #er B —(EAE NSRS EAEEE T -
6. HUREFBATEZ B EEE T - 1% yes (&) BZ -
7. BEHY Assay Active (ferHIEREN ) ErdEhial ([ 56) -

sdinistrater Assay MGHT 117161018
] ) [s]

Awsilable 2. available O ysilable wsilable °
AVAILABLE ASSAYS Assay01 Fun Test
Assay01 ’ Assay Active a
Respiratory >

0000000000001 e

English description e

1.0

LIS assay nams > e
ssa ’ Options
Type of Samples >

List of Analytes >

List of Controls > @

Assay Statistics > Log Out

B woon B e @ canen

B 56.EEhiH) -

6.7 [fcE QlAstat-Dx Analyzer 1.0

£ System Configuration ( Z44HRE) Dhaekd - WTLUEEE QlAstatDx Analyzer 1.0 ZAEHIER
B ESH -

6.7.1 EIEHHEE
ZHEDLU T B By QlAstat-Dx Analyzer 1.0 i B IEIHELE :

1. #77 Options (#E1H) %8l - #8&F4 T System Configuration ( Z44HR8) 48 -
2. eI HRRY Settings (BE ) JEELHERL Regional (&3 ) - MRIBFREENNERER 7 F
FIHAESE (T—H) -
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& 7V FEERUE

R i
Date ( HH#1) EHRGEEW (£ A~ H) CTHRE 57)

Time (HFRE)
Time Zone (H¥&E )

Date format ( H##&=L)

Date separator
( HEASBRRS%)

Time format (EFREAFEZL)

Language (F&&

TR A OG- 538i)
EELGIE

SEFHE - AL AREEE (T —HE 58) ¢
DD-MM-YYYY

DD-MM-YY
MM-DD-YYYY
YYYY-MM-DD (Ek37)
YY-MM-DD

SE B RERTSE - ALUUT AT ARERE (T —HE 59) ¢

-
-

- (B

/7,
EFEEE - AT A AIVESE (T—HE 60)
24 /\EF (hh:mm:ss) (BAED)

12 /NEF (hh:mm:ss a.m./p.m.)

FE (BER)

administrator

1 Available

SETTINGS
Regional >
General
Printer
Network
System Log

Technical Log

ViViIivIiIVIiv| v

Version Info

B 57 REHLG MY -

System Config 1451 2017-03-30

Run Test
REGIONAL SETTINGS DATE
Date > e
Time > ° View
Time Zone > 17 03 30 Genults
Date Format >
Date Separator > ° Options
Time Format >
Language > @

Log Out

® cancel
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administrator System Config

14:52 2017-03-30

Run Test

View
Results

©

Options

,_
)
)
°@
s

14:52 2017-03-30

Run Test

View
Results

©

Options

,_
o

a
°@
s

14:52 2017-03-30

Run Test

View
Results

©

Options

Log Out

_I Available
SETTINGS REGIONAL SETTINGS DATE FORMAT
Regional > Date > DD-MM-YYYY
General > Time > DD-MM-YY
Printer > Time Zone > MM-DD-YYYY
Network > Date Format > YYYY-MM-DD v
System Log > Date Separator > YY-MM-DD
Technical Log > Time Format >
Version Info > Language >
E] save ® cancel
B 58 REAGHBMHER -
administrator System Config
_I Available
SETTINGS REGIONAL SETTINGS DATE SEPARATOR
Regional > Date > 2017.03.30
General > Time > 2017-03-30 4
Printer > Time Zone > 2017_03_30
Network > Date Format > 2017/03/30
System Log > Date Separator > 2017:03:30
Technical Log > Time Format >
Version Info > Language >
E] save ® cancel
B 59.3%7E #4t H A bR ATas -
administrator System Config
-l Available
SETTINGS REGIONAL SETTINGS TIME FORMAT
Regional > Date > 24 hours 2
General > Time > 12 hours (am/pm)
Printer > Time Zone >
Network > Date Format >
System Log > Date Separator >
Technical Log > Time Format >
Version Info > Language >
[E] save ® cancel
60. BIE AMIRFRTAE -
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6.7.2 HEHEOE

IR DL N By QlAstat-Dx Analyzer 1.0 (EXUHEHERTE *

1. % T Options (EEIH) f2:ift - 24%4% T System Configuration (Z&t4HR&) %5t -
2. (/MBI Settings (F%7E ) AR PEE General (FH) - MRIFFTHZEEINLERE 8 1151

T -
%= 8. ANEHRRE
BE iy
User Access Control BZFH User Access Control ({#ifEFEIES]) » TERFTEFAEE ALY > W H HRESITH
({SEFHE D) {6 P B EAE S FAVERE -

Automatic log-off time

Qi)

Require password before
executing assay
CBITh AT R 205 )

Use Patient ID
(%L ID)

Prefer Patient ID Bar
Code ({R#F¥EHE ID fi&
f5)

Patient ID mandatory

(R ID By METE)

Sample ID mandatory

(BEA ID Ry MHIE)

WS BEFRRUT » BER IR - FrAEAE A - $HGE A Administrator (&
HE) SUERET

PHBEEETERL R -

HETERUA T User Access Control ( ffi I EEHUZER]) B » 5% B8R4 GRE) - 4 EEHR T

P QIAstat-Dx Analyzer 1.0 A HCEIT S [ ## AT 1B th A AORSTAIEING - iy
% 5 SYHCE 99 /N 59 58 - R ¢ 30 S

(P (OGRS - BT - BTSN LR AR ) A
RETE i -

SOSAE BN - (EFH T AT R0R (BIA0 » 72 Run Test TS 25k - S
BRI ER -

SUATERA T User Access Control ({EFHFEFEUZES]) I > 22 EE0EA FRE) - BUEhibaE
% > FrAERE Confirm (WEST) Fsti& a0 T 220 A B A SERTTAR0M) -

Use Patient ID ({Ef137% 8 ID) Bi@hi% » {E2EMHEITHIEES > QIAstat-Dx BRS RIS fyfi Fl &
FeitfE A Patient ID (J55fE ID) Bififs Patient ID (5 ID) HYEEH (2RI 5.3 ffi)
HEE f A B (6 P 3 o ST (o R B EL B8 4t Patient ID (JBEE ID) »

k=7 : Disabled (EYEH) -

FUATERLFA T Use Patient ID ([ ID) B - %S4 GRLE) - BB - (EFIBHEEYS

Seli AR E 1D SMEA RERITRRN - AISEARENES - AT DURHR B 1D Bk Bz -

k3% ¢ Disabled (EEMH) -

Eh% o [EREREEE A Sample ID (B24% ID) > SRR A BESITIGN « QISEARLEY - Al
{HFHE AT LU Sample ID (A ID) BEHEAI 22 > QlAstat-Dx Analyzer 1.0 @ [ @l2: piite
—fJ Sample ID (#4 ID) -

47« Disabled (TER) -
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(Rs@

RE

i

Prefer Sample ID Bar Code
(fR#FHEEA 1D fE%)

Exclude modules

(FREREEAE)

Number of results per page
(FHE&ERYE)

Show Previously Logged-in
User IDs (FRZ A8 AR
% ID)

Require password to log in

(REEHAREEN)

Restore factory default

CHAR TR B

HETE e A R 3 1 S (R (R B s L 254t Sample ID (B$4% ID) »

#k3Y - Disabled (2FH) -

W] LARHE TE B AT BERRE IEAE L TAVHERSN o A0SR e al PR B LThBERA
}Eﬁ o

2£37 : Disabled (E/EH) -

KFRIEEFE T View Results (gfissH) b B EHBRHIGEREE -

HAETERUAT User Access Control ((EFE{FRUZER]) B » a2 BEEA GRE) - 24sERL
itk - GEBAERE RERZ RIS ARERENEE -

EXEY ¢ Enabled (ELBTH) -

UETERIA T User Access Control ({88 I 77HUPZM) B > 5% 8804 G R - 4EERL
Flt& > FrAMEAE LA AL EIEABESA o EA% - HF6A User ID (% ID) B
aEA

ER3Y : Enabled (TUBH) -

A DURE 2 S B Ry T RO EE ©

6.7.3 EIFRMEE

%% Printer (E1FR14%)

ACIEBEH o ] ABENUZAREI R - QlAstat-Dx Analyzer 1.0 fuaf{if F4EES

ENFRAEAIE B 255 HHY USB B RER B R (EIRAH AT EN R

BHE DL B R QlAstat-Dx Analyzer 1.0 (S04 EIFH4%

1. % T Options (EEIH) f#ift - 741%4% T System Configuration (Z&t4HRE) %5t -
2. FEAERIFI A7 B P SEL Printer (EIFRE%) -
3. (EAHENRMORE R BN ([8] 61) -

administrator

1 Available

SETTINGS

Regional >
General >
Printer >
Network >
System Log >
Technical Log >
Version Info >

B 61 B AR -

System Config 1202 2017-07-03

Run Test
SELECT A PRINTER

PRINTER 4

View
Results

o

=
z
3
@

®

Log Out

® cancel
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6.7.4 iFEiH USB Z7HEF 1M

NI R USB JEBER A5 E 54

1. {fiFH USB R{EENFAMEIETHEIEISAHAY USB HFEHR - A 4 {f USB PSR DIFEH © 1 {E{E
A 3 EERSSRA -

2. EMEEEHIATAIHY PRINTER (E[IFRA%) BEIHERZRNT 3% 11.1 thATHtAyHsE CUPS Beghie - £
Printer (E[IFA%) w5/ TRUFHENZRM -

6.7.5 FEE KA LEEENFNE

F T YD BR8P 2 RS R AR 1A

e NI RE B Z R A SRR AL F T FREN A -
EEf% 11.1 s aEEs 22 CUPS Be#fest -
[i#IFf] QlAstat-Dx Analyzer 1.0 1% TR LS # BLE -

i/ Printer (E[IZ=4%) 3% E B EBREGHNTE] FBETERLFHENRA% (EZEEMEIRIE) > Rkl
Save (fF)

A

6.7.6 HErsEK

748 Network (48 ) BEHAF] LT QlAstatDx Analyzer 1.0 ZHFZEILERS - {FHIAERS EIF bR
HIS/LIS - ARATEC B8RS E HFHERN - SHIGAE AR EHE -

FIRDUT AP BRAE AR

1. #%T Options (ZE1H) f#ift > ZA{&f% T System Configuration ( Z#iHRE) it -
2. BSOS B R Network (488 ) (B 62) -

administrator System Config 11:50 2017-07-03
1 Available °
Run Test
SETTINGS NETWORK SETTINGS IPv4 SETTINGS

Regional > Enableipve (B9 Opainibve g e

address autom.
eral
Gener: > 5
Printer

Enable IPv4 (f’:f

Network > = e
IPv4 Settings >

System Log > Options
Technical Log >
Version Info > ’ » @
= . Enablecurs (B3 Obtain DNS  ggur Sl
=] save ® cancel
B 62.FL B4R E -
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3. IR AMEH BRI REINERT 9 THILUTEEH ¢

& 9MAMBUE

By

i

Enable IPv6 (EiH IPv6 )

Obtain IPv6 address
automatically
(EBERL IPV6 firtl:)

IPv6 Address (IPv6 firtil)

Subnet Prefix Length
(FHETERRE)

Enable IPv4 (B IPv4)

Obtain IPv4 address
automatically

(EBfEAL IPv4 firhk)
IPv4 Address (IPv4 firil)

Subnet Mask
(FHEREEEE)

Default Gateway
(THRREES )

Obtain DNS address
automatically

(E#fEHL DNS firhk)

Preferred DNS Server
({m#%F DNS falfiRes)

Alternate DNS Server
(f#5H] DNS falfz2%)

iU 1Pv6 fia ERI(ERT © 1PV Settings (IPV6 S0E ) TIHAERMELERUT T " Enable IPV6
CRA 1Pv6 ) BEFRACED -

FRFFAEE M DHCP fE4ERE JEHL IPV6 firfl: -

EHFHICENREEELN IPV6 firil - #%BEEME/E " Obtain IPv6 address
automatically ; ( EIEFEHT IPv6 firhik) {5 FHEFELE) -

TEFE IPV6 TGRS - 2 EEIE(E(E " Obtain IPv6 address automatically ; ( EBfEHT
IPV6 firik) {5 PRI ECE) -

B IPvA 13 5EfY{#E o IPv4 Settings (IPv4 355 ) FIHREFREFREUH T TEnable IPv4 |
(BH IPv4) BBy -

FUETHEE S DHCP {LMEFE &R IPv4 {irhE »

T3 FBC TR IF AL P4 firkl - 28857 ~Obtain IPv4 address
automatically ,  ( E1BHIEHT IPvA firkk) RS -

TEFE IPvA THHEE R - ZEIEE(E [ Obtain IPv4 address automatically | ( EBjEH]
IPv4 firsik) {5 FIEF Y -

FRIEEC RV EETE E S5 IPv6 BV, IPv4 THEERTE S o 3% IEIEEAE T Obtain IPv6 address
automatically ; ( HEHJEERY IPv6 firfil:) B¢ " Obtain IPv4 address automatically ; ( 5 &)
TEH IPv4 firkik) {2 FEFELE) -

FRETAEE 7 DHCP (EAEREIEH DNS 4HAE -

TEFHF T DNS (AR - 2% 8IEEE  Obtain DNS address automatically | (5 BJ&H]
DNS firii) {5 FIREELE] -

TEFKE DNS {alfilkes - 2% 5ETE(E7E " Obtain DNS address automatically ; ( HBfEH{
DN firfik) {2 FBFEE) -

6.7.7 HIS/LIS 50

W

RETH -

6.7.8 Z&EHk

ZARELSREC SR T ERER o BTSSR (0 A AR B Y — AR, o Iy SBR R o ~ iy SRzl -
B EEEH - NIEABELETE - #T Options (3855 ) ##8H » ZA1&$% T System Configuration ( Z4t4H
R8) fHsH > mARIE T System Log (ZRHELHK) RFEUARELELEN « SLBNBRERERHTFH L
EHUR " System Log Capacity | (A#ECEFAR) - # T Export Log File (PEHELEREZS) wILL
EHANE (T—HE 63) -
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administrator System Config 14153 2017-03-30

1 Available °
Run Test
SETTINGS SYSTEM LOG
Regional > Y pacty
100 Mb Refresh
General > -
View
Printer > pantilts
Network >
System Log > " . Options
Technical Log >
Version Info > Page 1 of 163 s 3 @
= PR Y . Log Out
B exportLogFile
63 I AL -

6.7.9 Rfracek

Rotracskacss 7o Aisa EATHIEIBT TR BTG - 2 EGERHE QIAGEN Hffifss Bl T5E
HEfJRfe - £ T Opfions (875) #%it - Z81&f% [ System Configuration (Z&usifE) sl - &%
T Technical Log (#¢fliacsk) AFHUIraCsk &N - ] DI ERGiracH o g ZE e - &(E
SCEREZ AT H BRI ) T TR - #%T Export Log File (FEHECEFMEZ) AILIEHAE
([& 64) - QIAGEN el n] AR R A oacss -

administrator System Config 12:03 20170703
—] Available °
Run Test
SETTINGS TECHNICAL LOG
Printer > 10 e
Network > View
2017 Results
System Log >
Technical Log >
5 Options
Version Info >

System Update >

®

System Backup >
Log Out

B 64 FFHUEATEH -
6.7.10 RRAEER
%~ Options (1) fZift - Z4&#% T System Configuration ( Z&EHRE) %8 - Hi&f% T

Version Info (FRAE) maR QlAstatDx [EREZEHEIRA ~ 2885 irisalny sl E 4k
zlg °
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6.7.11 ZHHH
EERR © 1.1 s SRR SE RO SIHRE R 1.2 -

FtREE R EMERE » SHEREERANE TR A - FERN B HATEHT > 551
support.giagen.com H% 4% QIAGEN HlifREHEs -

[
&

oy

WL ¥ QlAstat-Dx Analyzer 1.0 %45 » #% [ Options ( #ETE ) %5l - FR%B 4~ System
Configuration ( Z:&t4HRAR) 43l - {&$% T System Update (Z&EsEHT) - BEHL USB fFRUEE L7
AV AR dup FEFAR RS BB - FEIR—IREIE - BT 2%y (2%
% 6.7.12 &) (lE 65) - HHrfk » FIREFZOKEAERIE QlAstatDx Analyzer 1.0 Sl FZRELE) -

Making a backup is
recommended before
updating

© Proceed ® cancel

B 65 HfTHMEER -

6.7.12 ZHiffiln

WEFE ) QlAstatDx Analyzer 1.0 %475 - % T Options ( EEIE ) ###t > A& T System
Configuration ( Z4t4078 ) $#8H » Hf%& T System Backup (&&iffifn) (& 66) - K USB 1%
LB AR E Y USB EREE o

‘‘‘‘‘‘‘‘‘‘‘ cysem Ganfig
| avattie 2 aeseie 3 vataie 4 st (>
SETTINGS BACKUP R st
Regional > Make Backup >
HIS/LIS > Restore Backup »
Wiew
nter ’ Results
jystem Log >
Technical Log >
; ©
Optiors
>

& 66 BT RLEHL) -
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T Make Backup (fitffifn) %8 - & ABERRE R L AR SRy .dbk AYSCH: -

WNEIRSR ({0 > 5514 T Restore Backup CEEJRM(r) 281 - AMERHEHEIEEY USB (FIUEE FBEHE]
REFEA Ry Aok AT E IR OTEZE - HE R R EE R TR -

6.8 ZHH
ST FE A - ST Options (BE) it - #474$ T Change Password (SHES) -

H ISR s A B RIS (18 67) - ZR&R7E New Password et ) Mafr i AR &6 -
1E Confirm Password (HERZZME) M X A Ens (B 68) -

Iabuser Change Password 17:37 2017:03:30
User ID labuser Password
q w e r t y u 1 (¢} p
a s d f g h j k |
4 z X c v b n m <&l 123
X space v
H 678 A BRIELS -
Iabuser Change Password 17:372017:0330
New password Confirm password
1 2 3 4 5 6 7 8 9 0
/ ( ) € & @
0N ? 1 &  ABC
X space v
Bl 68 .5 AFTRERERT RS

=R A SEREV RS R o B A ALK &= o o I HERUR —(E BRI > PR
IPassword failed, please wait 1 minute to try it again ; (B > FBFHERF 1 7088 > ABESR)
HINSEE
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6.9 QIlAstat-Dx Analyzer 1.0 243 RFE
FRIERI TS AHATIRAE B8 QlAstatDx Analyzer 1.0 TEEHIIRFESS T (LED) HIBHMFET -
IR ATRERUR DU ™ R IRREERE

% 10 fiEFE T AT RE G EIRMERI TR EBURATIRARA -

* 10RBERHA

N FARA QlAstat-Dx Analyzer 1.0 &\ RiRf
[ QlAstat-Dx Analyzer 1.0 f£fFdaHi=t
o qe) QIAstat-Dx Analyzer 1.0 IEfE##E{T

S5 FHEA QlAstat-Dx Analyzer 1.0 ELAEF
[ QlAstat-Dx Analyzer 1.0 f£AFafEzl
“htn (P QlAstat-Dx Analyzer 1.0 IE{E ¥4
& TR IEAE T
AN Papin ik

6.10 [ QlAstat-Dx Analyzer 1.0

QlAstatDx Analyzer 1.0 FYs&aT o] DARFEETT - MOFHEEE (CRE[—RK) FHEAZEE - BfES
EIBE T ESREREEZTE QlAstatDx Analyzer 1.0 #E A fFFanfi=t - 415 R HF [ BE B
QIlAstat-Dx Analyzer 1.0 - z5REfEA QlAstat-Dx Analyzer 1.0 £ EAYEIFEARE ©

WFAFEHEESTE TR A E T THEE QlAstatDx Analyzer 1.0 #E Affantest » AIl&H
A EEEE TR > KT H ATERARN o SRAGSEROIEUETT - MR E SRR -
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7 HIS/LIS 743

A 4ET QIAstat-Dx Analyzer 1.0 Bl HIS/LIS ffyiHif -
HIS/LIS B & 7T L3 QlAstat-Dx Analyzer 1.0 5] HIS/LIS » $2{L & FREIIAE » HI40 :

® BEMIECES HIS/US HyiE(=

o RMECE > AN EEGERNHFELIFE
o RIETIEREITHE

o (X MHEER

7.1 EYEPAIECEEL HIS/LIS HYAE(E

1. 1 Options (#ETH) f%¢H - R1&81% [ System Configuration ( 454058 ) #2240 -

2. (MBI Settings (5¢E ) AR TEHEBTER AR HIS/LS (BitE s/ E=E:H
/%éfﬁ) ° IRIEFR AN ERR 11 FHIHAERE (T—H)

%= 11.HIS/LIS 3E

BRE Ey e
Host Communication BIH HIS/LIS i -
(ERERE) IEIETAR -

Host Settings ( EHGE%IE ) HETERAH T Host Communication ( (5 ) BF » s B80HA GRE) - At EET: |
MO HERT E ROV ERER « EHEAIE T DUZ FAAT 1P FIZFEE o Hid IP [ELMVER 4 (E8
fir (N.N.N.N) > N pAE7E O 5] 255 7 »

i iihak 5 IAHA HL7 CRARAEEAZ POCTIA)
BB A A - FAREZ DMS 5 LS -

FEIRFTHRRICE &y 5 1) | A DUERE] 60 b - i2/E QlAstatDx Analyzer 1.0 S5 %
ARSI

SRS R R Gl NESE esei=t
35EH\ Check connectivity (fg#s iz ) 280 - (EHE SR IP fIEBHRESE QlAstat-Dx

Analyzer 1.0 Bl FH09E( o
Result Upload (455 Hf#)  BUAI4EFEME QlAstat-Dx Analyzer 1.0 (#1245 FH#ATIHAE
ILEETETRE T -
Results Upload Settings HAETEBUHT Result Upload (455 Rf8) B » 2 BEEA SR -
(4R RHRE) G LR FIRERGER - EVEBIRITE) « BT EBERES - HR R EE

GESREAE|ERE - (= A B > T MR Summary (fi5Z) 1 View Results
(R R) BHTHY Upload (L) HART-EIMAGER - HEEEETHE 2 ©

Expire Time CZEHARFRHE) Z A ARG E AT EARATREL - 5 BER - LSRR
H - SRR BN EEE -

Reset Uploading (EEs% ) ] DUFHERHEAATERERTS] - AIRCEEE TEF245
R RPN R R R EAUS S0 - ZEHERAH -

Retry (EEeX) WILAENTMELE LEGRRE "Eror, (S53R) AYEER -

BT LA R E By Authorization (FZf) - DUE REEER - BRI AEHEAEMA T
AT -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

69



BE it

Test Orders (CGHIEH) R4 HIS/LIS Hr 37 HY T A BRI A T HIEREhRE -
BEBEIETHEAEA -
Order Settings SATERUA T Test Orders CHIGAEL) B - 22804 ERIE) -
(TAFRERE) Force Order (il T{FR) R LUEFTRIsS - ENGEEL T (i im S B - 502 80 Al

TR ID HHRAAY T.{EEE - Force Order (5@l T{FE) BEIETERIEH -

7.2 fHIAEECE

HIS/LIS shBURATIa 44T FTAEEL QlAstatDx Analyzer 1.0 EURHIIHIATEAE - [ HIS/LIS
THREAT » AT LU N R HERS/ ROIEAR M 247 -

1. $%F Options (EIH) f#ilt » ZA&$% T Assay Management (fafllEEE ) % #1ACHFHL Assay
Management (g HIEEE ) &5 - NEEIEAYE—BIE S T AR o

2. ¢ Available Assays (o] FHAETARM]) ThAESR HEEHURIHI -

3. #EHY LIS assay name (LIS fHI44F% ) #EIH - THERE X T » QlAstat-Dx Analyzer 1.0 F1
HIS/UIS g2 FEIEAEIE] « 415 HIS/LIS Hravkg M4 fEAR[E - HIFREETAIIELLSL QlAstat:
Dx Analyzer 1.0 fgl#4 8 —%2 - fEFH LIS assay name (LIS #4418 ) i ALz 4U1EARR
SRS - SR1% 1 Save (BE(E) f53E -

7.3 [EAEREREE I

B F Host Communication ( F=#%3E(5 ) 1 Test Orders CHIENEE ) 1% » AJLITE M FECHIEE - 28
1B HEETT -

TR AREA 1D & BB THFRECRIEIE -
7.3.1 {HHFHHERNCE QlAstat-Dx Analyzer 1.0

1. #F Options (2815 ) ##4H - ZA&$ T System Configuration ( Z4T4H%8) 8 -

2. {EEMIRAS Y Settings (%8 ) VAT BB R S 44t HIS/US (Bii&R RS/ EhEEH
25 -

3. RB{A Host Communication ( EME(E) Wi EMGFAIERECE Host Settings ( EMEE) -
## Check connectivity (fgas g ) fsnEarisss -

4. B Test Orders CHIEE) JGECE Order Settings ( TEEEE) - (EATHIBLEAYE A RI(E -

BlFF11E R Force Order (& TfFES ) 80 - B Force Order (5&H| T/EEE ) BF » 405K
HE M R T RREVERIENEE - AU A R B T, - {5 Force Order (58| T{FEE)
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> BEARIEHETHE R T A AR AEE - (ERE Ty T EEUET IS - R EPEe
LA -

7.3.2 RN EAETT I

1. RS bar © Run Test GETHER) 51 -

2. HHERE - I RERIEAE R SRS R s A 1D A% (B 69) -
e - MR8 QlAstat-Dx Analyzer 1.0 WYECE - 32 0] DAHE A et s 00 SR s oy A
A 1D - HRAFEAE R > HSRIE 6.7.2 6 -

sdministrstor Fun Test Moduie 2 1423161018
1 administrate Q A
Available Available t Available

TEST DATA

69 JRIEA 1D PREG -

3. B ID R AT 1% - QlAstatDx Analyzer 1.0 R HIGAE - I & IR  Getting
order--- ; (IEFEMERCHIEE---) RS (B 70) -
e+ AR TR TIRREEDRIEAEE > & Force Order (58| T.{FEE) #EIH /% enabled (T2
RFE ) B - RIS A S TR - & Force Order (5% T/ER) % disabled (EL{£H)
Bf o BIEEARRBHIEDIEEE - (FR B et (ZHE— e - HhErEER
B - AREREEERIESRIEANER > RS 9.2 -
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administrator Run Test Module 1 12:23 2018-04-05

Ul administrator

TEST DATA

smple ID
15 v
fssay Type Qe

“
ample Type
Cancel
Getting order...
& 70 BEEUNERERR IR

4, FEFMHEERIHERUHE % - B EE s T Scan cartridge for assay <assay_name> and book
order <order_number> |, (fFffsll <assay name> FIT{EEE <order_number> AYERE(E) -
faiteE QlAstatDx fefllsAr =AY RS (B 71) -
ek + BEATREE Rt 1D AR[EZ (EHEE - 218 &HOR ' Scan cartridge for book order
<order_number> ; (iFii LIEE <T{EH4RI> fUslA=) E - WIRMFHHY QlAstatDx &
HEREIS S TEREAR—2 0 RPAEUE TR AESE > Sl N EERER - AAREE
FEERAVETARE R - 5 9.2 i -

administrator Run Test Module 1 12:53 2018-04-05
Ul administrator

TEST DATA

15 v

Cancel
Scan cartridge for assay "Resp" for book order 2342343325

7L QIAstat-Dx R RIBAIRARES -
5. Assay Type CHafiPRL) Ml & B8 A > QURFEE - BEROSE IS T Sample
Type (HAGEL) (f& 72) -
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administrator Run Test Module 1 12:43 2018-04-05

JI administrator
Resp Panel

TEST DATA SAMPLE TYPE
ple ID

15 v Swab

Assay Type UTM

Resp Panel ~

Cancel
Select Sample Type

72 S AR -
6. 2%% 5.3 fill5ERkPE 5- 11 -

7.4 REAEEE R BRI R

FIF3 Result Upload (455 {8 ) 1 Results Upload Settings (453 &€ ) % > 7 LIEEIEF
R4S S ] % -

7.4.1 [tE QlAstat-Dx Analyzer 1.0 B4 8l b E a4 55 3 14

1. #7F Options (5 ) ###H » A& T System Configuration ( Z44HRE) 4 -

2. fEAAF T Settings (B ) BB EERES P S £ 4 HIS/UIS (BiE A&/ BREER
R&) -

3. B{A Host Communication ( EME(E) Wi A EMGFAIENECE Host Settings ( EMEE) -
% Check connectivity (FaiEE) $E 5T MEsT 8z o

4. FifH Result Upload (455 {#) - #A7&HCE Result Upload Settings (455 &2 E ) - BUA
Automatic upload ( H&) F{#) -

7.4.2  REEEIR BB LERER

HEGERR - g e EEEER - EEREBURAESE R Summary (F522) B4 Test Data (M
sEk) H5H View Results (st ) &5y & Upload (_L{#) %t (& 73) -
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administrator Summary 12:47 2018-1218

‘I Available °

Run Test

TEST DATA DiagCORE Respiratory panel

72 © Ccoronavirus HKU1 e

RP il © Mycoplasma pneumoniae View
Results

Ut™m

Pending e Options

© coronavirus HKU1

© Mycoplasma pneumoniae

®

Log Out
IS Print Report [E] save Report 2, upload

B 7363 Summary (%) B5 -

AT 77 (1 65 S BB P 2 AU IRAE + 354 T ok © View Results
(htisss) < & Upload (&) RN LEREE (& 74) -

administrator Test Results 17:33 2018-04-05
<| Available °
Run Test
@ sample D Assay Operator ID Mod  ®,  Date/Time Result
91113 administrator 1 @ 201804051722 @ pos e
3265 administrator 1 2018+ 0 pos View
. Results
administrator 1 ) 018- ] 7 pos
123456 administrator 1 @ 201804051639 @ pos @
02 administrator 1 2018:03:2211:42 @) pos gkticns
77701 administrator | 2018-03-22 11:40 @) pos
Page 1 of 2 > A @
Log Out

[£] save report £ search 1, Upload

74.View Results (BfR455R) BHE -

A RERURIY L EARAEEE R 12 - EHAERBUR T _LEIREE > Name (%78 ) #BURAE Summary
(%) #% > lcon ([E/R) BRIE View results (AgfRasR ) &5 -

12 FEIRARIHIL -
2 B it
Pending (#:E) SEF AR A -
Uploading (IEFE L{#) GERIEAE B -

Uploaded (timestamp) (£, =4 [HffkEC]) GERCA R B - B L H BRI -
LRGSR EE GBI - ) -
IEAEF R AEE R -

AT LR - CREDRIHEXET —X -

Error ($83%)
Re-Uploading ( IF{FEE#r %)

0RO

Expired (previously uploaded) ( Ei8#H [~ #iE. L))
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i = it
Expired (never uploaded) ( EL#8H [ 4 EH]) LT L EAS R o R -

7.4.3 [iiE QlAstat-Dx Analyzer 1.0 D8 R4S R T 1

1. $#%T Options (#EIH) $8ft - Z8%$L T System Configuration ( 484058 ) $ift -
2. {EEMIFHEY Settings (8%7E ) 7B BERUBE BT &30 4.4 HIS/LIS (Bli &l AR/ Hi=E &N
EXCDNE

3. B{A Host Communication ( Li#iE(5 ) WHH THEEFAHENECE Host Settings ( FHERE ) -

## Check connectivity (R ) 5 SHEERTESE -

4. BiA Result Upload (455 B{#) - #A{ZECE Result Upload Settings (455 FEHEE) - (2
Automatic upload ( &) &) -

7.4.4  FHGEERTE EER T

MERTEER - FTPAEAES Summary (F§%2) B4R View Results (hgifishs ) SaeF-8 FEERE -

AT LT Summary (F%) B05E HEsEE - #ik T D VP Upload ( 1-{8) #:4ft -

WIERHEFHENE View Results (FpiiissiiR ) &5 LEEER - QIATLUE TEEA ID 55V RIRE A —
(BB E S R - FrBtdE RV B G BUNKEECHE - ZHUMSEIUHEEER - SH TR -
T @ YspaH TR LS TS B - MEH A L% - 45 D e Upload (_1{4)
i (| 75) -

administrator Test Results 17:33 2018-04-05
F
-l Available °
Run Test
@ == Operator IC M, Date/Time Result
1 ato @ 201804051722 @ pos e
® om0 @ | | view

: Re | t @ 201804051657 @ pos e
p Par t @ 201804051639 @ pos @
02 p Pan a 0 3.22 11:42 e; o8 Options

7701 Resp Pane administrato 2018-03-22 11:40 @) pos

1 of > A
£ search 2, pload

I8 75.View Results (#4558 ) B -
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A T4A T QlAstatDx Analyzer 1.0 FEERI4EE(TTS -

8.1 4EE(LHS

% 13 f2fft 24 QlAstat-Dx Analyzer 1.0 FHEfTAVHEE(TAITEH -

= 13 EBEHRT
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¥} QlAstatDx Analyzer 1.0 RE#ETT — AIFEFEHRES « (LESSEWREA (WEEEARSM:) HE QlAstatDx
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8.2 ¥ QlAstat-Dx Analyzer 1.0 FH

EEET | A SEEiMeHERER
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EEIET | A SEERMRERER

JEEAT > 35 QlAstat-Dx Analyzer 1.0 EEES G fHFEENG -

QIlAstat-Dx Analyzer 1.0 5= f
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QlAstat-Dx Analyzer 1.0 $E5EE &
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o ZREK

B LT A B2 QlAstat-Dx Analyzer 1.0 32T :

1. WEER=TENEHR  FEERR -

2. FURAIADERRIGHRN - 2A&EH QlAstatDx Analyzer 1.0 Rifi - LUK FEEIRY TAE G -

LR NEFRRMYE R - WEUE R MR - 5561 QlAstatDx Analyzer 1.0 FElff
AR REAAT o
3. FEFIMTERMEENER 2 =K -
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5. {f#HakERZ QlAstat-Dx Analyzer 1.0 EH °
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BB - AR AEFEREE VRS - BRI EREARIEREUSAYELENE -
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4. [FFHFARDRETEE 2 f1 3 FHEEM X -
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WX -
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HAEEH QIAGEN HYJFSEE (M o [ AIREHAERVEN I RE S B EE - &
A (i RE S -

8.5 QIlAstat-Dx Analyzer 1.0 {Z#

QlAstat-Dx Analyzer 1.0 19 {EHEEH QIAGEN FIHE(CFEENTT - 415 QlAstat-Dx Analyzer 1.0
HITARIES > s 9 EinVaE & aTER4E QIAGEN FEfiTHRES L -

ASBEFEHERERR

sH705TBH QlAstatDx Analyzer 1.0 4pik - 3577 €5 4B B QlAstatDx
g%/%ﬁ Anal
yzer 1.0 -

A FIFASNEEAE BN QlAstatDx Analyzer 1.0 FJREAEL(# HI# 25 QlAstat:
Dx Analyzer 1.0 #8152 » i Er({fi (R RE 5 -
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SEHE

AEFRHE TR QlAstatDx Analyzer 1.0 I a]AEHIREY—LEfHIRE - DL AT RERYIRIRRIBRA T -
Hi RSB - WPk QlAstat-Dx fa I A AHBIRIRE - 5525 & BB AR -

WERFBEHE D) > FHEH T RS & R4S QIAGEN RS
44uk © support.giagen.com

[ QIAstatDx Analyzer 1.0 Hig#ifiiés QIAGEN HLITRFSEINS » 20 S SUanery S Bt
TiSR PR - BEREAEBITY QIAGEN HCHTHRES RSt -

FEBERH QIAGEN HEITIRTS AT  FIEMHAT LI TR -

e QIAstat-Dx Analyzer 1.0 Pk ~ JERIFIRA
o SEES (W)

o SHIRE RN EEL

o SHRASHERVIEE (BRI )
o BEIRIGR - AIFJRE

o CUHKERVEIA

9.1 BERCNIEKAGHRR

gesn HEERRE BRAER
The QIAstat-Dx Analyzer 1.0 QIlAstat-Dx Analyzer 1.0 3 iijz e JFF HEse QlAstatDx Analyzer 1.0 T 4R ET )5
does not start. (QIAstatDx [ o $TBH QlAstat-Dx Analyzer 1.0 %[ 1Y EE 5
Analyzer 1.0 SEE) - ) QIAstat-Dx Analyzer 1.0 & fifIEERR B -

RFTBH -

QlAstatDx Analyzer 1.0 it fsantizt - % M imEHsh - 2% QlAstat-Dx Analyzer 1.0 &

it

Analytical Module not RIEHE ST/ BRI - RR BRI A TR 2 PR O K IE R
detected. (RHHIEI I e
&)
The Analytical Module status T & il QIAGEN £z -

indicator is red. (53#TiEi4H
AREEFE TR R4l - )
The touchscreen does not  QIAstat-Dx Analyzer 1.0 JEfitffanfiisl ' Operational Module A% -
respond. (fliZEEREE] RIS RER) -
L A -
4% QIAGEN LIRS HD -
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TIREHIREA

BRAER

Bar code reader does not
scan. (GES#SEEEIR - )

The QIlAstat-Dx assay
cartridge is stuck inside the
QlAstat-Dx Analyzer 1.0.
(QlAstat-Dx i HstAl &~
1£ QIlAstat-Dx Analyzer 1.0
gre)
Lid of the cartridge entrance
port does not open. (&
ACIWETARITH < )
The Run Test button is not
active. (Run Test (3E{TiHl]
) EHREE) - )

Assay does not run. (fgfiloR
T e )

Result upload status is
“Error” . (455 L{HAVIRGE
Ky Error ($53) - )

A result cannot be uploaded.
(S5 BEEER - )

Cannot run a test because

there is no test order. ([X}%

7 T 2 2 O

R

REUHEEA ID RESIHAE -

(REE R B 17 E B R SR R -

B -

TRAE PR e -

=B &51E QlAstat-Dx Analyzer 1.0 [N »
WG QlAstat-Dx RIS HES - 241%
QlAstat-Dx Analyzer 1.0 A FE¥ T3 HI

-
TEAHAR T A -

(EIE LA R TR AR -

RAE QlAstat-Dx Analyzer 1.0 thzzi s

Mo
AR R AE e -
BRI (E AT -

FEEHTERTHRE -

GERIRET B -

A ID 2 A AIEE - HIS/LIS 3RERU T

Force Order (&I T/EEE) -

BA LIS Y BHF{ERT - HIS/UIS 35 AL
FHT Force Order (G&#| T{EE) -

FHlesE = T EREE BN E QlAstat
Dx Analyzer 1.0 I {5RBLIAE

R4S QIAGEN FHiHR S ED <

4G QIAGEN FE 1R -

R4S QIAGEN RfTfiRFED

Module ( f554H) HRAE31 AR E RS
“Eject cartridge ; (HEHEAIE) F - T
BRAHURASAE - 41T Eject (HEt) -

SRR EIAR A AT IR AR Y R A I e
e
IR E RS EEE -

BEGEN - IS R E R e B
ST B R R R A
FEERAL R -

S R L R R S B SRR
8 > ZERATLRIIE 60 ) - MFCLRE
BRI BT TER M AR VA -
LA FEEE CGRABFIR - 3R
RE--) FE4E T AR - R4 QIAGEN Hefiifiis
# -

S B S R S B HIS/LIS
S Expire Time (A 37 -
4G LIS BHLE - 1 US PREHZHEA D
FTAEEL -

e E = TSR E T AR B E T
i -

SLETTENE AR > S51E HIS/US g iz
i Force Order (G| T{E®) -
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9.2 FEBIELENE

SRS

2

BRAER

The AM in the slots has
changed. ({&fEdry AM E
G - )

Making a backup is
recommended before
updating or restoring. (&%
AE SRR T A T
o)

Shutdown not possible.
Please stop all tests and eject
cartridges. (#/ARHRA - 515
AT A kR

)

Free disc space ddd reached

warning or critical level.
(ddd Ay AT A iR 22 e 5
BERETAE <)

The system was not shut
down properly last time. (%
& E—TCRIEHRR - )

Test result with invalid data

found. (A ERER
HYHIEREESRE < )

Unexpected behavior of AM
nnn. (AM nnn HIREZIMT
B

Update data aborted, error
occurred. (BRI L -
HEREER )

No backup file found! ( F+k
FIFERE )

Assay <assay_id> not
available. (&} <assay_id>
A <)

Code (fCHE) : 0x400

Assay <assay_name> not

active. (gl <k&flARE> &
R - )

Assay <assay_name>
already imported. (&l
<assay_name> CLFEA o )
Code ({{H5) : 0x0304
Import assay failed; the
assay file is invalid. (&I
AGRHL s RS 2R - )
Importing ADF <adf_name>
failed. ([# A ADF

<adf name> Z:H - )

Code (f£f) : 0x0305
Login failed! (&AM ! )
Login failed! (B AZHL ! )

The user is not activated.

CREZFIFEAE - )

ORI R E T - 2/0E—
TR DA Ry HoA (i -

FHERES o RS - BRI REE
FEK o HOT AR RSERER -

HEIEAE TR > QlAstatDx
Analyzer 1.0 fitLRHEA -

T QIAGEN Hfli iR ET A& %

&t LA INERS MNIRERRZE ]

ZEAESITIEFRARRAPH - b —{EHEE

BATREEEE -

B TONEARART - BRSNS -

I -

B QlAstatDx Analyzer 1.0 HFR =SS

RAE USB AL E T I ERERIH (515

% .dbk °

ANFEL QlAstat-Dx A HIE | mAH B FERTiR
JIPE A QlAstat-Dx Analyzer 1.0

TIARE -

B AP AL FIARE 1D RIRRARY

gl

DN i E S

DN i E S

BRI -

{#F#E9E#H QlAstatDx Analyzer 1.0

i -

T SE R LR - BN BB T & - 20 H
B THCE -

R IERET R (D MRS

SHERPHIBSER - SSET IR E > MR TIRARA 2

S QIAGEN RffTfiRFEED

FER SR I B R S IERES RARA D AT 68 - 281
eSS E I EIFFRR RS - SHETRE
SRR - 2055 6.10 EffTiL -

BT QlAstatDx A MIEUA S ERT = T
o WRREGFAESAH IR > 55504
QIAGEN s a -

HEIREN R - WRMERENEFE - 4
QIAGEN FilifREsHE -

FAEEE QIAGEN FifgARas . -

A USB TR s B /2 e - AR
TAFAE - FEHR4E QIAGEN RLAlTfRFESES -
rtaoHIbE A QlAstat-Dx Analyzer 1.0 ( 552:R5
6.6.2 fifi) -

Faptadl (G215 6.6.1 i) -

IR AT ZER - SERRTERERTIRLE -

FHRGE from www.giagen.com g5 Eicha HIRE
F o MR 554 QIAGEN £
AR -
FHRGE from www.giagen.com g5 ke HIRE
F o WIRAIPAH IR R 554 QIAGEN £
R -

S E R T E SRR -

SRS B B T SR A BRI
(FH2H% 6.5.16) -
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SRS

2

BRAER

Login failed! (& AZH ! )

Wrong Password! ( ZfEE
]

Login failed! (& AZH! )
User identification does not
exist. ({EFFFAERNE
£

Passwords are not identical!
(A —E )

Invalid Password! Min.
length 6 characters. Max.
length 15 characters.

Allowed characters: 0 - 9,
a-z,A-Z, _, space. (fiE3g
T | B/ NEE 6 lHFT -
HKRE 15 {@5T © st
WFIC: 09 azAZ~ _
ZEtE o )

Export failed! ( p&EH 4

Bt )

USB Device not found. (#
) USB 354 - )

Bar code reading failed. (f¢&
WS EL - )

Failed to scan bar code. (

VAR - )

Test failed, Error:
<error_code>. (JHlEfscHT -
FeaR - <$ERRAEE> - )

User has no right to execute
assay <assay_name>. ({#H
H8HET <assay_name>
HIFFATHE - )

Code (fUHE) : 0x0402

Cartridge already used. (&
AR - )

Cartridge expired. (&#Fil&
AT - )

Different cartridge inserted.
(AT AFENER )
Failed to create file. (A%
TREHE o)

HIS/LIS timeout (HIS/LIS #
BE) -

Results in state "Uploading”
or "Expired" cannot be
uploaded (fi7% E{E#RREFy
VIEAE R B0 TR
HY&ER) -

i ARV R -

BESEEEE-Fi EEEN

MERGER &S - WA AR RIA 2

B -
HEAFFEL R -

SESE R ERIRT » BTR M

RAE QlAstat-Dx Analyzer 1.0 g%

USB iR
AT ERIE -

ARAE Z9 T B A (S F R RS ARG -

MERH - R AR -

[EFE AP TR IZERE -

LB 2 A I AEAY QlAstat-Dx 1

/Ej‘itﬁﬁjml °

fAHA QlAstat-Dx f AR & -

B -

fl AT QlAstat-Dx fa s = i

eI TR = — 2 -
fREI RS

FRESHI LIS Z PRy (S Tkl -

SR EHC RIS

HEE

HRTS R

EEESHRRERy "Uploading ; (IEfE R

8 0§ QAR L -

E%iﬁﬁ)\%ﬁb‘%ﬂ’ﬂ%ﬁ 5tk 195%%%@%(14
» RIRA R RERBA - ARTEE - 55
w%@%a%aiﬂiaﬂé SCERTE ©

AR RS E T A B E AT (A

AR (A EI A2 -

SRER/VI 6 {EF T B 15 (B ThyE
5 M6 H RAEE & ATV FIT 09~ az AZ
o ZEfE

ERTRAF - R > 5#hi4E QIAGEN
Rl -
4 USB 7 A A USB JfEIE -

S QIAGEN RffTfiRFED

(AR T BE CLACHEE - (H AR [E]RY QlAstat-Dx fi
& -

WRREAHTFE > 55hi4% QIAGEN FE k%
Hh e

AT QlAstatDx g HlEt7 & o g Tl
i o MR > Ak QIAGEN Ffifik
Bl R SR R -

a[ LA User Management ({EfHEEH )
MR TIHERE (F5SRI5E 6.5 6i) -

TR AH A 22 4 FOpR BEUA A BR 2R 57 A 28T QlAstat-
Dx g flsA A& - SEFHT QlAstat-Dx faHlsAAl &
TR, -

FOETHER QlAstat-Dx f a7 o AREEAHRE
IR H A PR R & o

A BLE IS SRR AH [E]H QlAstat-Dx it
s o

USB fFRUEEE R IEH TAF - S EFERARE
USB EIAEE

T HIS/US §%5E FAVRBERFE G s (E - 415
R ERAME » FHi4E QIAGEN Fffi R %30 -
B LAE HIS/UIS 35E7E H 8 B asiiig Ry -

KA "Uploading ;  (IETE Bf#) Lf#i% - w]IL
P AR -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

84



SRS 2

BRAER

The maximum number of
results for upload <num> is
exceed <num> (K45
HEE <num> CACGHE#E
<num>) -

No book order for this

sample Id. Do you want Settings ( T{EEi&%

CEE R L EE RSB -

LIS FIR[EKEA ID A3HIEAEE - Order

TE) FEEF Force

continue anyway? (%A Order (&I TEE) 3%E 8 (disabled |

ID A TAEE - {24 (FERD -
g ? )

Order not found (GRIRFEI T LIS KiR[A|FEA ID A HIELEE - Order

fEEE) - Settings ( T{E& %

TE) T Force

Order (&HITIEE) & Tenabled |

(B -

Ordered assay not installed  £ff QIAstat-Dx Analyzer 1.0 thZZ4EHE

CRZHETIERER) - B EERATARM -

QlAstat-Dx Analyzer 1.0 tf &M 445 £

LIS EUAMI R AT A —2 -

No connection to HIS/LIS
(CRHELE HIS/US) - o

LIS f1 QIAstat-Dx Analyzer 1.0 7 fjf i

HUMBER — L5 5 » 2R E -

REEERR - EREADIE MRS R
LIS " AFFER LIEE -

R - HERE AR R ATRER H LU TR
LIS REAREA ID AU TAFE - B EHE
FEPERE

LA EATREA

FRAE HIS/US SeE TRy LIS fal4af
s HIS/LIS 3558 Y BE AT AR
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103 RS

TAER
BREOR 90 - 264 VAC
50 - 60 Hz
IEC 60320-1 C14 }HE
REEA 1x8A JEHF
R 15-30°C
R 20 - 80% THENR - IE 45
T 0-2200 m
. % 4000 lux

N
e
=
Cor

RS 0-55°C (32 - 131°F) » fx AFHEREE 85% » JE5 4
EHEEM: (EMC)
EMC B3k %4 IEC 61326 A %

SRS CISPR 11 A BUEST T et AR - (ERERIE T > MRt G EA R
ST WRHIREREED > RS T -
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PRI RETIAE

EE (it

R~F HE: 234 mm
=5E 326 mm
VERE 517 mm

HiE 5 kg

papIL KN

R=f HE: 153 mm
=& 307 mm
VERE T 428 mm

Hi 16 kg

LKA T 1x 10/100 - Base-T Z. K48

USB iR 1B 16 - &1 3 E
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11.1 CUPS EIRAEREN L (27 5

CUPS (ZEH] UNIX FIEIZ4 ) 2—(E$tE Unix BHIEERGIFE ZR4RAVTIEI 2% - 7T LU QlAstat-Dx
Analyzer 1.0 Operational Module {E &E1ZF(EARES - BIHAATA PostScript® E[IZFEf%F1JE PostScript
BIENE%H - CUPS g PPD (PostScript E[JF2f&fH i ) BREHFE S - QlAstat-Dx Analyzer 1.0
Operational Module TH5%45T PPD ERENME - (HETAFLL LEEETEREHE -

fixE © QIAGEN MACRESIFTA IR QlAstat-Dx Analyzer 1.0 - AR MEATEN R
HIBE > sE2REIER 11.2

SEH LU B L AR EI AR TR

1. 7£ QlAstat-Dx Analyzer 1.0 Operational Module 2= {# 4 Options --> System Config >
Network -> Enable CUPS (315 -> Z44HAE > 4888 -> B CUPS) rhEgE) CUPS » sR1& 1%
Save (f#fF) fEfFsE (MRIZLAM S SRERRT) -

2. #Eih Web B E85 A CUPS (Orfi © http://10.7.101.38:631/admin) -
=¥ 7[LIE Options -> System Config > System log -> Enable CUPS -> looking for the
field "applicationsoftware started" (EEIE > Z454HAE > Z4RECEE —> B CUPS > &

"HEFIHRESTRREN ) ML) TNHEIVEZERIZIY IP Ak -
ERLITEREA

User name (ffEF&%FE) * cups-admin

24 ¢ QlAstat-Dx Analyzer 1.0 Operational Module F&Ff2=#fe Options ~> System
Config ~> Network ~> CUPS settings ( #ETE > Z4f4HAE > 488 > CUPS 258 ) Higfitayss
B -

3. ¥ — TAdd printer ; (HrigEIFE#E) -

4. (EHERSTh T S ERAYEN TN E B b BRI EI A - Z8(& 4% T T Continue ,  (4848) -

5. JEHY Share this printer (HFILENZRME) 2412%% Continue (445) (T~—HIE 76) -
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& ‘ 3 Add Printer - CUPS 2.0 X | + v

T O] (D) 10.7.101.138:631/2dmin

Administration
Classes

Help

Jobs

Printers

Add Printer

Add Printer
Name: [HP_Officejet_Pro_6230 |
B " (May contain any printable characters except "/, "2", and space)
. _[HP Officejet Pro 6230 |
Description:
dable description such 23 "HP Laserlet with Duplexer”)
Location: | ‘

(Human-readable location such as "Lab 1")
Connection: socket://10.7.101.237:9100
Sharing: Share This Printer

CUPS and the CUPS logo are trademarks of Apple Inc_Copyright © 2007-2015 Apple Inc_ All rights reserved.

76 FEIRIE RS -
6. BEIEHIBIEIFMEETIIL, - &I T TAdd Printer | (FRRSEIFENE) -
FERE ARSI EN BB AR T IR B IRt » AR5 B
st AR S {EABRS L Tk PPD 2SHatHg CUPS BEBHfZSt » 75 T Or Provide a
PPD File , (SHRfiE PPD ) M PEEENE > ZAfd% T T Add printer , (HHYEIF%)
(& 77) -

&8 ‘ B3 Add Printer - CUPS 2.0.0 X | B

& = O m (D 10.7.101.138:621 fadmin

CUPS org
+ Home
+ Admimistration

o
)
o

Add Printer

Or Provide a PPD File

Add Printer
Name: HP_Officejet_Pro_6230
Description: HP Officejet Pro 6230
Location:
Connection: socket://10.7.101.237:9100
Sharing: Share This Printer
Make: HP | Select Another Make/Manufacturer |
HP Color LaserJet Series PCL 6 CUPS (en) ~
HP DesignJet 600 pcl, 1.0 (en)
HP DesignJet 750c pcl, 1.0 (en)
HP DesignJet 1050c pcl, 1.0 (en)
HP DesignJet 4000 pcl, 1.0 (en)
Model:

HP DesignJet T790 pcl, 1.0 (en)
HP DesignJet T1100 pel, 1.0 (en)
HP DeskJet Series (en)

HP LaserlJet Series PCL 4/5 (en)

HP LaserJet Series PCL 6 CUPS (en) v
3 Examinar..
Add Printer

CUPS and the CUPS logo are trademarks of Apple Inc. Copyright © 2007-2015 Apple Inc. All rights reserved.

77 BEHEIR SRR, -
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7. BEHUEHERT Media Size (/MERST) (Bl TA4 ) o R R —SEEIRARAEARGRAS A SRR A
GHIEN - #ETAC > 5T ' Set the default Options | (SUETHELEEN ) ZACEE{FEEN ([# 78) -

8 [ Set Printer Options - CL X | aF

S o O Gy @ 107.101.138:631/admin

* Administration
* Classes

« Hel
* Jobs
* Printers

g

Set Printer Options

Set Default Options for HP_ Officejet_ Pro_6230
General Bamners Policies
General

Media Size:

Color Mode:
Resolution:
Media Source:
Media Type:

Starting Banner:
Ending Banner:

Error Policy:

Operation Policy:

http://10.7.101.138:631/admin

CMYK  ~

Plain Paper

Set Default Options

Banners

<
<

none

none

Set Default Options

Policies

II

stop-printer
jefault

Set Default Options

Ia
II

78 . BEHVIFREMY Media Size (NMERST)

8. FHEH QlAstat-Dx Analyzer 1.0 Operational Module #X1& -+ 5 DL EEENFE = -

9. 7 Options > System Config > Printer (3T > Z&R4HAE -> EIFME) TEUHZZESAYEN 4% -
BENUFTERIVENRAE - ZM&TE Save (7 ) - EIRMBEIERTA(EA -

11.2 Z&OHEHYENFRARIE B

DUNENFtdtas 7 QIAGEN AYMIE AR QlAstatDx Analyzer 1.0 (£ USB 12 A )

e HP® Officelet® Pro 6230
e HP Color Laserlet® Pro M254dw
e Brother® MFC-9330CDW

EETE 11.1 hAviErr - HAEIRE AT RE A A QlAstat-Dx Analyzer 1.0 -
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11.3 FretiE

VA e BUE R AR AL

QIAGEN GmbH

QIAGEN Strasse 1, D-40724 Hilden, &[]

AT QIAGEN s s FH 35 T MU Y 7+ & 1
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11.4 g+ R (WEEE)
A By P B T 4 O T R R R

FIX AR ASIEARR ST () fonItE A B A YY) — FRE DR B AL AR
P PRSI RRS - DUSEARIR E AR AR B -

A J BRI BRI R A [ U B Y B SRS 1 AT EAPRE B N ER - LW ORDAOREE A SR RN R E 6 U5
U i

QIAGEN  FI{EUR S K IR BHS MCHUER FAET TR - fEBREE - 35T B ARy WEEE F[E|rEK |
WHREREMZH QIAGEN {2t - RIa] Dl BB HAT A WEEE fR5EHY B SRa (i -

W R E TR > SRS E Y QIAGEN A &M ia AT TR AR [EI#A% - 1262
RFRIE% » QIAGEN FRAEEGHKLEAER - LIEZLPFE T YR SE R R -
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11.5 BH{EFRRK

WRAZHECHTEARETHEEESEE - Al QIAGEN FRIE(L(TIREIZER - QIAGEN i
TR R R It T B PRI FRID -

BEPRE N HIFT A FEEME G R A IRESHAN G EIORIE - BAEEAEI TR e A RE R R G
FAGHI > BRIE QIAGEN AEIE BEHMHE < SHHCKE « /A ENIAH BRI (& AT S R i
YRS R PR (LAY PR EH A E S IRE - B8 QIAGEN RFAE ML A A FRRA
ORIED > QSR ER I PR [ P RRIBR (- — 2@ ze > HiIE QIAGEN @A - BRIk QIAGEN
HYE B A -
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11.6 WHGET Al fihek

QIAGEN GmbH, QIAGEN Strasse 1, D-40724 Hilden, [ ( "QIAGEN ; ) Fiffs (fEEE=UEA
) o HIEEE (TIRERSE) By 2 MRAR R IRRI TR (k)

B AR E RN E A ATRE TR G R B T ARSI R - QR FERAGRAK
AR ESISNIBEINEVIEE (AfEEEAR) BEFEESEMAITT - &S AREHT 2
IR -

1 T

HE - IRIBATRAVPGRIRIE - QIAGEN T IGEBRIERK A ~ FEME S EA iR IAE -
RE R ICHI N ERZE H B A E -

AT

® ([EUEER AW EESUTMEY AR AR EEAERE S 0F - A REReA R

AL AT AH RCER 7 ARG 0B > So/NERIFAETA R AFFRURER A AIE L T > A RERALOTAEE R

SHILIE T AR~ SRR T at B P S RS R A S 2 BT A E T
1

o WME (EERIIIRI)

o R QIAGEN FSBEIEE « DUEFIMA LR AT « 658 - e - 15 - 25 - i
Y T AR S [ TR

o i - S - BB - THESI AR AT - B - RN - SRS

o DUETRIL QIAGEN sl AT Eufth 71y i 7 R E M MR 2K (0 AR ©

o {5 PR B (T EL A SR R R -

RN - Ak R st E— G B _ L g — R4 -

SUAHRRA - ZEAEAVERTREGFE 30 (=-1) RIZMEH - R S5TA1 -

FRBCERES/ 5 =78k - At~ E A P e S A2 fHRE R T RIBIRIRESS ~ IR/ Sih
FEREZRAY AL A BT (SefE " BRCRES ) ) - BbAh » AR B QIAGEN &1
RTLTAESE A EREMEE (TS0 ) o BRBCRER RS =70 1] AR DA S A
FEIRVETAERIEAY - EREMERILHAFERIEN - RS2 GPL SULMEMFTIRBERILY
o

QlAstat-Dx Analyzer 1.0 i # it 04/2019

94



WF QIAGEN FE{HEEE = J78hs - AILIHEE = TR I PRRKR S8 N R G DAL Rt - 4052
(T RARCERES - RIS RE RO AR R FOR BRI N A A DAL R 2 AN SRBH AR A HE R R
FEDR QIAGEN (AR AR AR AR A IE A T2 RS - Al QIAGEN JRHE(E - A1 Rk
B = TR A/ SRS - QIAGEN KB » WAREERIR BUAH EAY R (RAX -

2. A
AR N ATRAT L ISR O R A » 17 EL R A LA A
B+ BRIE 20 EL A MR TGN A R 2 IR A 5 — T P+ T R
4 AL -
3. it

e (BIEAREE P EErEEEGN T ) RS - 2 B AR B RE R E IR
i o WA EAWASREI A TTENRIAT Y} -

4. HARRH
EA B B AR - E0RARERC B P MPR 2 EAE S - A BB R EA AR

AT AR AR R R R I A 35 AR R e E A R (E A - IS O TS A TR
[ S e SRR AT T R B & R AN IR A e TRRAS

QlAstat-Dx Analyzer 1.0 i # it 04/2019

95



5. ARIER

QIAGEN {3 © (a) BEMEUE]Z HEES L+ (90) RMRES L IR HIEN MM EHELT - ARERAIFT
AEURIREEERSLT (90) K - Fibd/mAMEE A AAFFIRHFIBURIREEATIAIR - Rt EAtfRH T AE
HHIEAE -

6. FHFHIRREETE

QIAGEN Hy&HIFATAEAYIE—fREEHTIFZE (FH QIAGEN #EHU) (a) B Z(THIERE (b)
BAEREHRAT S QIAGEN HIR{REE CHf IR R4 QIAGEN HYRUAS - AIFRARHIRZH
PATESN ~ P ERER P AT > FIACH FRYE PRAESL o (a7 S HR AT s B AT 2 AR (R ] S R R ] Y
= (30) RPRIE - LA RH R2tE -

7. HAREME

FEAEMEILT > QIAGEN AL RERG A A (o F A AR M S 2L HEE (B E
AR EEFEABEIRR BB - BRI ARSI - A HRVIRE - BRI
JE ~ HEHREEEEL - RV BEREL - SE =TT RBERAVIES) KIERE - HIE
QIAGEN L #ERI Al RE 4 IR -

B BRI P REET RERE B L SR A S GEREMRE - SN ERTEE
(Produkthaftungsgesetz ) ~ #E{RECEMUEEGRHIAA CHIEMELE -

AR AR LR -

o DRI -
o REETREIIRL -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

96



8. ik

AR AL EIT A GiRb] QIAGEN Ry ARESIEHH (TS24 - QIAGEN L (HI2H %)
B IE ARG AL IR AL/ 2 A ARG I A RE T fR LT - IOER S HES T R QIAGEN
SRR AG TS AVEMTEARE - DS HSCERBSHIEE TR -

QIAGEN #fA#E (RFEMERS IR ) MUEMSIR (MRA) HIEE HHER IS R iR E
B -

9. &Ik

WNERAE P AGRAVERIR G » QIAGEN B LASS (A e DA R S8R50 P ASHR BE AV REFIAIAAE -

(S FTLUB BT QIAGEN 4 (A » At 1118 - (OB A TR RO P %
O -

TREZ R R AT % - QIAGEN B LU E S i (il B R BT -

10. EEEAHE - FHM

KR ER BB AR AR - HASEUARIGKEZE - T e THaBHEA Y, fK - &E
finatk THHAME - Al THIS T2 AL2E M 2 A BB EE -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

97



11.7 G E A

k7T QIAGEN 17 QlAstat-Dx Analyzer 1.0 SHEGERFIRETFATANE » QIAGEN RNERIET(TE
£ tEAE/EL AR QlAstatDx Analyzer 1.0 (AL R R IRES > EIEEHNME - BER:
TEFRR ~ BB TAT A - RS 2 BRI S Y (TR R -

QIlAstat-Dx Analyzer 1.0 Fiffg 2 K4g8 882 - QlAstat-Dx Analyzer 1.0 £ &fE&FTEVIFTA

B - ek~ NG - EEETER - BEARSREP R 2 =M - QIAGEN HHE[SHE -

fEaa ~ AN - RS - BE ARSI AR & 2 A RIS E R EE -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

98



11.8 flirzB+

L34 (Analytical Module, AM) : QlAstat-Dx Analyzer 1.0 {91 ZERFALEAH - &2 QlAstat-
Dx fa B G A TR - B #R(FI54H (Operational Module, OM) #E1TH%H] -

MEERE W E SR QlAstatDx Analyzer 1.0 FH#EFTIR IR AT FRIVIEZE - RN
PrEET AT BUETTHIE ~ a0fal 170 8 DU R A bl AR B AR 5 - E B TheHIAT - IERZ R
FEZPE A QlAstat-Dx Analyzer 1.0 -

GUI = [EIALE &S -

IFU = {ERIEREA -

ER{FIE4H (OM) © QlAstat-Dx Analyzer 1.0 HAHRERS > fy 1 £ 4 {E50474H (AM) $2HEERE T
i -

fEAZE © DITERA 5 =CE(E QlAstat-Dx Analyzer 1.0 A -

QlAstat-Dx Analyzer 1.0 i # it 04/2019

99



=5

R B A B
i EIR R R
g
b %
TR E

BT T] A AgH]
TRt &R
par. el
ECE B RERE
BHEre
R AR ETT
LN
FiE QlAstat-Dx Analyzer
AR

PN GOE Ry

36 A P T HER
CUPS ENZ=i&BEETE 2 4
FrE R
REEH
FEARAIEEERE

RpL =g

K& R

HHEE
HEhEH
PEBRSAH
R ID Ry MEIE
fRITEE ID fHRE5
fRIFEEA ID B
RS
WRAE R THE(E
A ID Ry hHIE
A E ID
{57 F & A a2

fiTsE=

HIS/LIS s
FAENFIBC BB HIS/LIS 1YiE(E
IR E

53
89
55
88
56
56
54
54
54
61
37

9
67
58

40
40
88
91
98
83

7
61
61
62
61
61
62
61
62
61
61
61
99
69
69
70

fii'® QlAstat-Dx Analyzer 1.0 BLE @)

EEAGE R 2 L%

73

il ® QlAstat-Dx Analyzer 1.0 PLF-8 -

GG R B A%

75

{8 F BRI E QlAstat-Dx Analyzer

1.0

71

{5 TR R Y 71
&R Summary (f5%) & 74
FEAE G B A A T A 71
BERR A PR R 76
PRI AE SR B 8 T % 74
R GE SR 8 T % 75
PRI GESR I A% 73
View Results ({45 ) &% 74,76
HIS/LIS %78 64
TigmE 70
T 70
HEFER 9
PR AGET R 57
LHERE P 18
GHSEEIN TR 25
THIAR & 7
B 93
LR ENFA% S B 90
BN 49
R 51
EE 46
P, 49
HHRREES] 47
TIRERY 48
TELHIIRRES 47
i 77
2 QlAstat-Dx Analyzer 1.0 £mH 77
5T QlAstat-Dx Analyzer 1.0 =@ 78
QIAstat-Dx Analyzer 1.0 {Z# 80
A2 RS 79
BT A AGH] 56
NN L v | 57
s 63
Rt 9
EEIRIIRER 51
Order Settings ( T/FEEZEE ) 70
I 67
MM QlAstat-Dx 7 & 32
Pk VAN e R I 63
% USB ZEEENFRA% 63
ENFtiast e 62
HIENHR S 45
FIEN 39, 44

QlAstat-Dx Analyzer 1.0 i # it 04/2019



HEE TR 33
QIlAstat-Dx Analyzerl.0 22 {5 HloH: 19
QlAstat-Dx Analyzer 1.0 f#f 14
QlAstat-Dx Analyzer 1.0 £ 80
QlAstat-Dx Analyzer 1.0 Z 45 REE 68
QlAstat-Dx S| &t 16
@I E 58
HHA 59
BE 59
5 59
EHaSERIE % QlAstat-Dx Analyzer 1.0
31
GEER 70
SR FEEE 70
LTI
OB ET 37
MR 34
HEH QlAstat-Dx E{7 2 35
A QlAstat-Dx =& 35
GEAL Summary (FE%E) Rk 36
BUTHF R 35
R QlAstat-Dx s & RIS 33
R 1D (A5 33
B AR 34
I tiss R 38
T HE AR 4SS 32
FEE MG B A A M
FRECHIE R Y B - 72
R 1D A 71
il QlAstat-Dx 1 HlEA R & HEHS - 72
BERURAE 73
g 9
LEER
Y 12
ety 11
BWRZAE 11
TEHE(HE 10
Fro 13
EERTRT HE 10
FEEYIRE 13
G 39, 44
R S E R 51
HsER 44
AV IERERY Media Size (/&R <) 90
HEEVENFARFEENIE S 89
FAEA QlAstat-Dx Analyzer 1.0 68
HREEOR 18
RS ] ohask 94
BLE) QlAstat-Dx Analyzer 1.0 32

ENSh
HHEE
HIS/LIS 27E
MRS EEE
T 2 M LSS
7 USB ZHEEIRE
ENFtEEE
IR E
e )
ERSN
R
Fefiratsk
hAE R
EGRip
FZHRINRE
T R &
ST
lii & QlAstat-Dx Analyzer
BARR
TR
BEIHTNRER
QlAstat-Dx Analyzer 1.0 4 iR5E
R IRESEEE
e
fHFEEE
F AR REFIEETE
G W
Esq 7]
ESq ik 23
Feftring
R
HeCE R ARG TR
TAERAF
SRR
R
SEEEHRA
PRI
RS BE 25
[ rxt
PrREFIZE4E QlAstat-Dx Analyzer 1.0
{58 FH B A2 il
EFEE
FRRE RS EE
g E S
teolaRat &Rt
Sylicel
Sy s e AR
fFERER

61
64
63
63
63
62
58
66
64
66
65
65
14

56
67
58
49
46
51
68
51
68
52
46
64

65
86
86
87
86
86
70
81
83
81
81
21
61
52
53
55
54
54
54
52

QIlAstat-Dx Analyzer 1.0 {£H& Tt 04/2019

101



IRss R 38
P 4R 39
SRR 40
PfEHHE] USB Badzs 44
SRMERGR 40
R 40
Jfi Hh g 40
TR R RS A 4 39, 40

ATREHIAE R

Z AR

BIENGER

SR

HEEEAEER
25

JEEY B

43
42
45
44
41

92

QlAstat-Dx Analyzer 1.0 i # it 04/2019

102



HESTREAZEC R

XAHERT IRk

fETHCA 1 PG o FIRERARAR 1.2.x 50 -
HB-2636-001
2019 £ 4

QlAstat-Dx Analyzer 1.0 i # it 04/2019 103



AHRBZEEE

QlAstat-Dx Analyzer 1.0 i # it 04/2019 104



i : QIAGEN®, Sample to Insight®, QIAstat-Dx®, DiagCORE® (QIAGEN Group); ACGIH® (American Conference of Government Industrial Hygienists, Inc.); Brother® (Brother Industries, Ltd); Clinical and Laboratory
Standards Institute® (Clinical Laboratory and Standards Institute, Inc.); OSHA® (Occupational Safety and Health Administration, U.S. Dept. of Labor); PostScript® (Adobe, Inc.); HP®, Laserlet®, Officelet® (Hewlett-Packard
Development Company).

BRI » AR R - PR R e G R R A R R -

PostScript® J& Adobe 7£35EUR1/ SCEEN 5/ L M AR akra £ -

HB-2636-001 04/2019

© 2019 QIAGEN - {REIFTATER] -

QlAstat-Dx Analyzer 1.0 i # it 04/2019 105



=THE © www.giagen.com/shop | $%fli7#% : support.giagen.com | 445 © www.giagen.com

04/2019



